Cours Mathematica (Version 2006)

C. Coste

Physique avec Mathematica. Introduction
genérale.

0) Note sur la presentation

Toute Fonction Mathematica citée dans le texte adopte la typographie des cellules de commande
[voir I-1) ci-dessous], comme sur cet exemple. Toute touche du Clavier, ou intitulé de Menu, est en
noir sur fond gris. Les remarques purement syntaxiques faites au cours du TD seront en rouge et
en gras a l'écran.

) Introduction

I-1) Effectuer une commande

Avec Mathematica, vous pouvez réunir dans le méme document, appelé Notebook, du texte (y
compris des typographies mathématiques), des demandes de calculs et leurs résultats, ainsi que
des graphiques. Notez les accolades carrées a droite qui délimitent une cellule (Cell). Dans le cas
présent, il s'agit d'une cellule de texte.

La cellule ci-dessous est une cellule de commande. Vous effectuez la commande en sélectionnant
cette cellule avec la souris (ou en activant le pointeur a I'intérieur de cette cellule) puis en appuyant
sur la touche Enter du clavier. Effectuez la commande ci-dessous.

Notez la différence de typographie entre les cellules de commande, de résultat, et cellules de texte.

1+1

NB 0 : Tant que vous n'avez pas explicitement entrée une commande, celle-ci n'est pas prise en
compte par le logiciel. Une fois qu'une commande est effectuée, il lui est attribué un numéro d'en-
trée (In[#]) et un numéro de sortie pour le résultat, lorsqu'il s'affiche (Out[#]). Ici le résultat s'affiche,
et le numéro doit étre 1 pour I'entrée et la sortie.

NB 1 : La valeur par défaut de toute frappe au clavier est une cellule de commande. Pour changer,
par exemple en une cellule de texte, sélectionner la barre de cellule a droite, et naviguez dans les
menus Format -> Style -> Text

NB 2 : Les cellules de textes sont inactives.

I-2) Sauvegarder le Notebook

En effectuant cette commande, vous avez modifié ce document. C'est le bon moment pour vérifier
que vous savez sauvegarder un document!

Allez dans le menu File->Save As

Méme si votre compte personnel est actif, je vous conseille de sauvegarder dans le dossier docu-
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ment du disque dur du PC sur lequel vous travaillez, et de transférer le document dans votre
dossier personnel en fin de TD (qui se trouve physiquement sur un autre disque dur, accessible en
réseau). Ensuite quittez le logiciel, et rouvrez votre document. Vérifiez qu'il s'agit bien de la version
que vous avez modifié!

Par la suite, n'hésitez pas a sauvegarder aussi souvent que possible! Faire File->Save sauveg-
ardera automatiquement dans le méme dossier du disque dur.

I-3) Opérations numériques

La multiplication s'écrit avec le signe *, ou plus simplement en laissant un espace entre
deux nombres ou deux symboles. Attention a ne pas oublier cet espace!

2%3
2x3
23

Remarque : La numérotation des entrées/sorties permet le rappel des résultats, qui s'écrivent %
Pourcentage % (résultat précédent), %% (résultat avant le précédent; généralisable a n signes %) ou
%p (p-ieme résultat). Cette écriture condensée est pratique, mais oblige a un ordre chronologique
strict dans les calculs. On peut s'en affranchir en donnant un nom aux résultats (quels qu'ils soient;
voir 1I-5).

Quelques exemple d'utilisations de cette syntaxe :

%+ 2
%3 "2

 %%%%

I-4) Syntaxe des fonctions Mathematica. Délimiteurs

Toute fonction Mathematica débute par une Majuscule. Ses arguments sont délimités par
des [crochets droits].

Sin[r]

Les {accolades} délimitent les listes, dont les éléments peuvent étre quelconques.

Voici un exemple de liste numérique (vous remarquerez que lI'argument de la fonction sin peut étre

une liste de nombre, le résultat étant alors la liste des sinus de ces nombres. On dit que sin est une

fonction qui posséde l'attribut Listable, ce qui est le cas de la plupart des fonctions Mathematica.

Certaines ne le sont pas, on y remédie au besoin en utilisant la fonctionnelle Map, décrite au TD N°2)
7T Tt T 7T Tt

Sin({n, — —, — —, —

i} 2 3 4 5 6 }]

Et un autre exemple comportant deux listes : une liste des fonctions dont on fait le tracé, et une liste

donnant le domaine de variation de la variable.

Plot[{Sin[x], Cos[x]}, {x, O, 27}]

Enfin, les (parenthéses) ont exactement la méme fonction qu'en mathématiques

3% (2+5)

Vous avez peut-étre noté I'emploi d'un point-virgule lors de I'utilisation de P1ot ci-dessus. Le point-
virgule a pour effet, sauf pour les fonctions a sorties graphiques telles que pPlot, d'empécher
I'affichage du résultat. Cela permet d'obtenir des Notebook bien plus lisibles, et doit étre encour-

ageé lorsque le résultat est évident (définition d'une variable) , inutile ou trop long (construction d'une
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longue liste, par exemple). Ici, en son absence, une cellule indique la nature graphique de la sortie.

I-5) Utiliser l'aide en ligne
Pour obtenir des informations sur n'importe quelle fonction, il suffit d'entrer une requéte ou elle est
précédée d'un point d'interrogation
? Sin
? Plot

Avec la version 5, ces explications sommaires sont suivies par un lien http vers I'aide en ligne.
Cliquer sur le lien permet d'accéder a plus d'informations. Les fonctions ont un ou plusieurs argu-
ments (un pour sin, deux pour Plot (la fonction a tracer -ou la liste de fonctions a tracer- et le
domaine de variation de la variable, qui est une liste), et des options. On accéde aux options d'une
fonction par la requéte options

Options[Sin]
Options[Plot]

Sin n'a aucune option, Plot en a beaucoup dont les valeurs par défaut sont indiquées.

I-6) Structure du logiciel

Mathematica, d'une certaine fagon, est constitué de deux logiciels. L'un, le FrontEnd, assure
l'interprétation des commandes de l'utilisateur, et en tire une représentation interne qu'un second
logiciel, le kernel utilise pour les calculs. L'interpréteur retranscrit alors les résultats sous une
forme lisible par I'utilisateur. Un schéma général pourrait-étre celui-ci :

Erterpr Calculateur
Utilisateur

FrontEnd Kernel

Une requéte peut ainsi étre codée de différentes fagons, toutes acceptables par l'interpréteur. Voici
une demande de calcul d'intégrale formelle, en explicitant la fonction Integrate, puis en utilisant la
palette standard

(menu File -> Palettes -> Basiclnput )

Integrate[Sin[x], x]

jsin[x] dx

Cet agrément de lecture a une contrepartie, parfois facheuse : on oublie trés vite que ce qu'on voit a
I'écran ne correspond pas nécessairement a la structure interne de Mathematica! En particulier, une
écriture aussi simple que a+b a exactement la méme structure interne que toute fonction Mathemat-
ica, comme on le voit en utilisant FullForm :

FullForm[{a+b, axb, ac, Jf[x] dlx}]
ou de fagon équivalente, en notation postfix
{a+b, axb, ac, Jf[x] dx} // FullForm

La fonction FullForm a précisément comme objet de fournir a I'utilisateur la représentation exacte
avec laquelle travaille le Kernel.



4 | Cours_Complet.nb

II) Quelques opérations basiques

lI-1) Effectuer un calcul numérique

Si les valeurs numériques sont entrées sous forme entieres, Mathematica s'efforce de fournir un
résultat exact, et laisse la requéte inévaluée s'il ne le peut pas. Si les valeurs numériques sont
entrées sous forme décimale (lorsque les nombres sont terminés par, ou contiennent un point qui
est le séparateur reconnu par le logiciel), il fournit une approximation numérique calculée avec 16
chiffres significatifs (Sur Mac, en version 4.2; ce nombre est une variable par défaut, notée
$MachinePrecision - le § précéde tous les paramétres par défaut-).

Vous noterez que Mathematica connait les angles en degrés, la notation ° correspondant a la

JT
constante —
180

$MachinePrecision

sin[{;—r, 5l 3, 3., 3 0.3333, 45 °, 45. °}]

Pour obtenir une approximation numérique, on peut aussi employer la fonction N.

N[Sin[{;—r, 51 3, 3., ;—, 0.3333, 45°, 45. °}]]

Voici une syntaxe différente mais équivalente, la notation postfix.

sin[{1 X 3,3 1 0.3333, 45°, 45.°}] // N
5’5.1 4 'l3l . 14 14 .

Ces calculs peuvent étre faits avec une précision arbitraire; N admet comme option le nombre de
chiffres significatifs requis, mais ne les calcule que si I'erreur sur les données initiales permet
d'obtenir la précision demandée. Par exemple, pour obtenir un résultat a 25 chiffres significatifs, les
données initiales doivent comporter au moins autant de décimales, ou étre "exactes", c'est a dire
sous forme rationnelle. Les constantes usuelles, telles que 1t et e doivent étre entrées sous forme
symbolique.

N[;-‘, 25]

3.1416
N[ ——, 25]
3
Toutes les fonctions numériques sont définies dans le plan complexe (lorsque cela est possible,
bien sar!)

ArcSin[2.]

sin[£+1«/7] // N
3

lI-2) Effectuer un calcul symbolique

La grande richesse de Mathematica vient de ses capacités de calcul symboliques. Citons les dériva-
tions (Derivative), intégrations (Integrate), recherche de solutions d'équations (Solve), intégra-
tions d'équations différentielles (psolve). Les deux premiéres n'ont pas besoin d'étre explicitées,
mais peuvent étre codées avec la palette.

Derivative[1l] [Sin] [t]
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Sin'[t]

Syntaxe : bien noter que le prime s'applique a la fonction!
Nous verrons au TD2 que l'opération de dérivation est en fait une fonctionnelle, c'est a dire une
fonction s'appliquant a d'autres fonctions.

Ot Sin[t]
Xy Xy Xy Xy
{6x,x r ax,y 4 ay,x 14 aYrY }
1+y? 1+y? 1+y? 1+y?
x
Solve[ax,Y Y =0, y]
1+ yz

Syntaxe 1: premiére apparition du double signe égal, qui sert a définir une équation.

Il est indispensable de ne pas le confondre avec le signe égal simple, qui sert lui a nommer
une variable et sera décrit au paragraphe II-5). En cas d'erreur, Mathematica interpréte ce qui
est sensé étre une équation comme une définition, sans aucun contréle de I'utilisateur, ce
qui peut donner lieu a des conflits de définitions. Soyez donc attentifs dans I'écriture des
équations.

Syntaxe 2: Notez aussi la structure particuliére du résultat; il s'agit d'une liste de régles de
substitution, sur lesquelles nous revenons dans le TD suivant.

DSolve[x''[t] + w?x[t] =0, x[t], t]

Syntaxe : Faites attention; x" est codé par || [l Il <t ras rar | I !

Il est possible d'introduire des conditions initiales; le premier argument de la fonction est alors une
liste d'équations (toujours écrites a l'aide du double signe égal)

DSolve[{x''[t] + w®x[t] =0, x[0] =a, x'[0] =0}, x[t], t]

lI-3) Effectuer des calculs numériques plus compliqués

Des fonctions comme Solve, Integrate OU DSolve n'ont souvent pas de solution exacte. Il est
néanmoins toujours possible (lorsque seules des valeurs numériques interviennent) d'obtenir une
approximation numérique. Pour Integrate OuU Solve, on peut appliquer N au résultat, ou utiliser
directement les fonctions NIntegrate et NSolve

Remarque : Pour DSolve, il faut appliquer la fonction NDSolve, qui n'a pas tout-a-fait la méme
syntaxe que DSolve et que nous étudions au paragraphe suivant.

Jqup[Cos[t]] dt
0

N[%]
NIntegrate[Exp[Cos[t]], {t, 0, 1}]

Solve[x5 +3x*+5%x3 +7x%x%+9x +11 ==o]
N[%]

NSolve[x5 +3x*+5%% +7%x% +9x +11 ==o]

Comme autres fonctions utiles, nous allons évoquer les fonctions FindRoot (recherche numérique
de racines d'équations) et FindMinimum (recherche numérique de minima de fonctions). Ces deux
fonctions admettent deux syntaxes différentes.

NB : Dans ce type de calculs, il est trés fortement recommandé de tracer d'abord les fonctions. Le
point de départ de la recherche est en effet crucial, et on n'obtient pas nécessairement le méme
résultat selon le choix initial.



6 | Cours_Complet.nb

Plot[{x-1, +x%-3}, {x, -0.5~, 3}]

x+1

Premiére écriture : lorsqu'une dérivée formelle de la fonction a étudier est calculable.

1
FindRoot[x—l == +x2-3, {x, 2}]
x+1

FindRoot[x— 1== +x2-3, {x, 0}]

x+1

FindMinimum| +x%-3, {x, 0.5}]

x+1
Deuxiéme écriture : indispensable lorsqu'une dérivée formelle de la fonction a étudier n'est
pas calculable; facultative lorsque la dérivée existe. Il faut cette fois fournir un intervalle, et
Mathematica recherche la solution dans cet intervalle.

FindRoot [x - 1 == +x% -3, (x, {0, 2}}]

x+1
. 1 2
FindRoot [x -1 == +x%%-3, {x, {-0.5, 0.5}}]
x+1
FindMinimum| +x% -3, {x, {0, 1}}]

x+1

lI-4) Résoudre numériquement des équations différentielles ordinaires

La fonction NDSolve n'a pas tout-a-fait la méme syntaxe que psolve car il faut impérativement
fournir le bon nombre (égal a I'ordre de I'équation différentielle) de conditions initiales (plus
rarement, on peut trouver des solutions en fixant des conditions aux limites; mais a la différence du
cas précédent, I'existence et l'unicité de la solution n'est pas garantie).

Par ailleurs, remarquez que, pour I'utiliser ultérieurement, nous avons donné un nom (sol) au
résultat du premier calcul.

sol = NDSolve[{x''[t] + x[t] ==0, x[0] ==1, x'[0] =0}, x, {t, O, 10 7}]

La solution, dans I'approche la plus simple de résolution numérique d'équations différentielles, est
une liste de valeurs numériques correspondant a des intervalles de temps équidistants. Mathemat-
ica donne la solution sous forme de fonction interpolée (InterpolatingFunction) qui permet de
calculer les valeurs de la fonction en un point quelconque, grace a une interpolation (meilleure que
linéaire) entre valeurs calculées successives.

Syntaxe : Comme la solution est donnée sous forme de régle de substitution, nous utilisons
la syntaxe x[t]/.sol qui signifie en clair "Lorsque la fonction x apparait dans une expres-
sion, elle doit étre remplacée selon la régle définie par le résultat nommé sol".

Plot[{x[t] /. sol, x'[t] /. sol}, {t, O, 27}]

L'instruction suivante est un test classique perméttant de vérifier la précision de la solution
numeérique. La fonction Random[ ], qui donne un nombre aléatoire entre 0 et 1, permet de faire ce
test sur des valeurs "typiques".

Table[{t, x[t]?+x'[t]?} /. t > 10 x RandomReal[] /. sol, {5}]

[1-5) Définir une variable globale

On définit une variable globale a I'aide du signe égal simple. La variable peut étre de n'importe
quel type (numérique, symbolique, graphique, etc...). Nous venons de le faire en définissant la
variable sol.
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a=3

Notez que lors de la définition d'une variable, Mathematica imprime sa valeur. Cette sortie étant
parfois inutile, on peut finir la requéte par un point-virgule

a=4;

b=114+2%;
gl = Plot[Sin[x], {x, 0, 2 7}]

Ces variables sont "globales", c'est-a-dire que leur définition est désormais valable dans tout le
Notebook. On peut désormais obtenir des informations sur les variables auxquelles nous avons
assigné une valeur

?a
?b

Vous noterez que la deuxiéme définition de a a écrasée la premiére! On peut maintenant utiliser ces
variables

b2

Show[gl, Frame - True]

[1-6) Annuler une définition de variable globale

En informatique, et ce quel que soit le langage utilisé, une fréquente source d'erreur est le conflit
entre variables. Voyons un exemple.

Solve[a2 -3a-5-= 0]

Cette instruction échoue car a est désormais une variable globale, et ne peut plus étre utilisée
comme variable muette. En effet

a’-3a -5

est bien différent de 0! Il est donc trés important, quand on change de probléme, de supprimer
toutes les définitions de variables globales. Pour cela, il existe la fonction clear

Clear[a, b, gl]

?a

Si maintenant nous essayons a nouveau de résoudre notre équation, ¢a marche!
Solve[a2—3a - 5= ]

Ceci étant, lorsqu'on résout un probléme, on peut étre amené a définir plusieurs variables lors de la
recherche, et il est fréquent qu'on s'y perde un peu au bout d'un moment. Si on se trompe dans
I'écriture d'une équation, en mettant un seul signe égal au lieu de deux, on crée ainsi des définitions
incontrolées, et une situation inextricable! Dans tous les cas, il peut étre alors souhaitable d'éliminer
toutes les variables, pour repartir sur des bases saines.

Une premiére solution, assez brutale, consiste a quitter le Kernel. Toutes les définitions sont alors
automatiquement supprimées, et il suffit de ré-exécuter les instructions dont on est satisfait. Il suffit
de naviguer dans les menus et faire

Kernel -> Quit Kernel -> Local . Une fois ceci fait, il faut entrer a nouveau toutes les requétes néces-
saires.

Une autre solution, plus astucieuse, consiste a utiliser l'instruction suivante :

Remove["Global ™ *"]
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L'explication derriere cette ruse de Sioux est assez longue. Vous la trouverez dans I'appendice 11-9,
que vous pourrez d'ailleurs lire quand vous serez plus familier du logiciel.

lI-7) Listes, vecteurs, matrices

Les listes sont une structure fondamentale du logiciel Mathematica. Délimitées par des accolades {
et }, leurs éléments peuvent étre eux-méme des listes, et sont séparés par des virgules.

Elles sont frequemment utilisées comme arguments de fonctions (domaine de variation de la vari-
able dans Plot, ou NDSolve, liste d'équations dans solve, DSolve, NDSolve, efc...).

Elles apparaissent aussi trés souvent comme résultat d'une requéte, et il est indispensable d'appren-
dre a les manipuler correctement.

Une liste peut bien sar s'écrire directement au clavier. Les listes unidimensionnelles sont des
vecteurs colonne, les matrices sont écrites lignes par ligne, chaque ligne étant elle-méme une liste.
On les visualise avec la fonction MatrixForm. Voici quelques exemples:

{a, b, ¢, d} // MatrixForm
m= {{lr 2! 3}! {41 5, 6}! {71 8l 9}};
MatrixForm[m]

Remarque importante : Ceux et celles d'entre vous qui sont habitué(e)s a des langages
moins évolués seront peut-étre frappés par la simplicité d'utilisation de Mathematica. ll n'y a
pas a se poser la question du type de variable que I'on définit. Mieux, on peut changer ce
type en réaffectant a un symbole donné une autre expression!

m[[2, 2]]

m=3

m[[2, 2]]

Il est possible d'écrire les matrices a l'aide de la palette, paramétrée par défaut pour des matrices 2
x 2. |l est possible d'écrire des matrices quelconques en utilisant le menu Edit -> Expression Input
-> Add Row (pour les lignes) ou

Add Column (pour les colonnes). On peut aussi utiliser directement le menu Input -> Create Table/-
Matrix/Palette et configurer la matrice ou la table désirée dans le menu qui apparait alors.

La fonction permettant de créer des listes est Table. Ces listes peuvent étre symboliques ou
numeriques

Table[ai, {i, 1, 5}]
Table[0.14i, {i, 1, 5}]

1 .
mm = Table[ ———, {i, 0, 4}]
9 +i2

Elles peuvent étre de dimensions quelconques. Construisons par exemple la matrice m définie plus
haut :

Table[i+j-1, {i, 1,7, 3}, {j, 1, 3}] // MatrixForm

Syntaxe : Les éléments de toute liste sont appelés entre [[doubles crochets droits]]. Cette
notation est une abréviation pour la fonction part

mm[[3]]
Part[mm, 3]

Dansm[[i,3]], qui est une matrice, i estle numéro de ligne et j le numéro de colonne. Une ligne
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étant elle-méme une liste, il est équivalent d'écrirem[[1]][[3]]
m[[2, 3]]

m[[3, 2]]

m[[2]]1[[3]]

Appel de la deuxiéme ligne

m[[2]]

Appel de la deuxiéme colonne

m[[All, 2]]

Pour extraire plusieurs éléments d'une liste, il faut procéder ainsi :
long = Table[Prime[i], {i, 1, 100}];

long[[{1, 2, 3, 4, 5}]]

long[[Table[i, {i, 1, 100, 5}]]]

Il est impératif de savoir manipuler des listes, car bien souvent les réponses sont données sous
forme de liste de regles de substitutions, comme nous I'avons vu en 1I-2) et 1I-3).

Une des difficultés avec les listes est de bien traiter leur structure, qui peut-étre extrémement
imbriquée. Commengons par cet exemple qui parait simple, mais se révéle un peu subtil.

sol = DSolve[{x''[t] + x[t] =0, x[0] ==1, x'[0] =0}, x, t]
La requéte suivante ne donne pas le résultat escompté...

(x /. sol) [u]

| 9

Tout vient de la structure de sol, qui est une liste de liste (deux niveaux d'accolades imbriquées!). Si
on se réféere au bon élément, qui constitue une liste de régle de substitution (a un seul élément), on

trouve un résultat correct :
sol[[1]]
(x /. sol[[1]]) [u]

Il est donc trés important de bien analyser la structure, parfois compliquée, des listes fournies
automatiquement par Mathematica. |l existe une fonction trés puissante, Flatten, qui permet
d'obtenir toujours une liste d'éléments, a partir d'une liste aussi imbriquée soit-elle. Comparez
solbis a sol calculé précédemment!

solbis = DSolve[{x''[t] + x[t] =0, x[0] ==1, x'[0] == 0}, x, t] // Flatten
(x /. solbis) [u]

listex = {1, 2, {3, 4, {5, 6, {7, 8, {9, 10}}}}};

Flatten[listex]

On peut aussi supprimer progressivement les imbrications

Flatten[listex, 1]

Do[Print[Flatten[listex, i]], {i, 1, 4}]

Finissons par une remarque délicate, qui peut étre laissée de cété en premiere lecture. En utilisant

FullForm, on voit qu'une liste n'est jamais qu'une fonction comme une autre
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liste = {1, 2, a, 1]'
4

FullForm[liste]

De ce fait, la fonction part ne s'applique pas seulement aux listes, mais en fait a toute fonction
Mathematica

liste[[4]]
liste[[4]1]1[[1]]

liste[[4]][[2]]

[1-8) Exercices

Exercice lI-1 : Pouvez-vous interpréter le résultat suivant?
i T 1
N[sin[{-, —, 3, 3., —, 0.3333}], 25]
5 5. 3
Exercice 1I-2 : Calculer les coordonnées des points d'intersection entre la droite y = ’Zi et la tangente
hyperbolique (attention a la notation anglosaxonne Tanh)

Exercice lI-3 : Calculer exactement l'aire entre la parabole y = 2 - x? + 3 x et la droite y = x - 1,
lorsque la parabole est au dessus de la droite.

1 2 3
Exercice ll-4: Entrer avec la palette la matrice ‘71 2 g . Extraire sa deuxiéme ligne, puis sa
10 11 12

troisieme colonne. Construire directement cette matrice avec la fonction Table.

Exercice lI-5 : Reprenez la liste 1istex définie plus haut. A partir de cette liste, obtenez par quatre
instructions successives les listes des nombres de 3 a 10, 5a 10, 7 a 10 puis enfin 9 a 10.
Nettement plus difficile : faites le avec une seule ligne de commande, en programmant une boucle
Do, en utilisant la fonction pPart et la fonction Fold (ou FoldList, qu'il est d'ailleurs fortement
conseillé de regarder pour comprendre comment fonctionne Fold).

[1-9) Appendice : Nettoyage du kernel.

Il arrive que des erreurs successives (trés fréquemment, I'écriture fautive d'équations avec un seul
signe égal) introduisent des conflits de définition inextricables. Nous avons déja vu une solution, qui
consiste a quitter puis relancer le Kernel.

Il existe une fagon plus astucieuse d'obtenir le méme résultat, en utilisant la fonction Remove[].
Nous allons d'ailleurs partir de bases bien contrélées en nettoyant le Kernel!

Remove["Global™ *"]

[1-9- |) Fonctions Clear[] €t Remove[]

La fonction clear[] supprime la valeur attribuée a un symbole, mais celui-ci reste présent dans la
mémoire du Kernel, comme on le voit pour les exemples ci-dessous

a=3;
a
?a

a est bien définit dans le contexte Global (voir point suivant), et prends la valeur 3.



Cours_Complet.nb | 11

Clear[a]

?a

Aucune valeur n'est plus attribuée a a, mais il figure toujours dans le contexte Global.
Remove[a]

?a

?b

Désormais, a ne figure plus dans le contexte, de méme que b qui n'a pas été défini.
Nous pouvons retenir que la meilleure fagon de supprimer une définition malencontreuse
d'une variable est donc d'appliquer la fonction Remove[].

[1-9-2) Notion de contexte (context)

Au cours du développement d'applications dans Mathematica, par exemple en réalisant un
Package, on est amené a définir des variables dont ils est indispensable que les noms n'entrent pas
en conflit avec ceux d'autres variables. Par ailleurs, il est souhaitable que ces noms soient courts,
pour que les programmes restent lisibles. La notion de contexte permet d'avoir des noms abrégés.
Deés que vous commencez a travailler dans un NoteBook, les symboles que vous définissez sont
dans le contexte Global.

x=1;

Context [x]

La variable x a désormais deux noms : un nom abrégé, x, et un nom complet qui est Global" x.
{x, Global " x}

Le caractére " est I'accent grave, correspondant au code ASCII 96; si on ne le trouve pas sur le
clavier, on peut taper

FromCharacterCode[96]

et faire du copier/coller!

Toutes les fonctions prédéfinies de Mathematica appartiennent au contexte System. La fonction
Context n'est pas Listable, d'ou la commande ci-dessous :

Attributes[Context]

Context /@ {Plot, BesselJ, Sin}

Il n'est pas possible de redéfinir par inadvertance une variable du systéme.
Context[Pi]

Pi = 4

Dans un NoteBook existent deux contextes, system pour les fonctions prédéfinies et Global pour
les fonctions définies par I'utilisateur. Régle d'or pour éviter les conflits : Toujours commencer ses
propres fonctions par une minuscule!

L'action de la fonction Remove est de supprimer toute définition propre a l'utilisateur du contexte
Global, sans toucher au contexte system. x est correctement éliminé, par contre pi reste défini.

Remove[x, Pi]

?x
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Pi// N

[1-9-3) Conflits entre contextes.

L'exemple typique ou cette notion de contexte intervient pour un utilisateur peu expérimenté est
lorsqu'il tente d'utiliser une fonction d'un Package avant d'avoir chargé celui-ci.

e
PolarPlot[Exp[ E] , {6, 0,8 7r}]

L'instruction échoue car PolarPlot n'est pas définie par défaut, il faut charger un package.Mais le
simple fait d'entrer une commande fautive fait que PolarPlot appartient désormais au contexte
Global, ceci de maniere totalement involontaire, et incontrolée.

Context [PolarPlot]

De ce fait, lorsqu'on charge le Package Mathematica identifie le conflit, mais pas nécessairement
de maniére trés transparente pour I'utilisateur, surtout débutant!

<< "BarCharts™"; << "Histograms™

; << "PieCharts
(2]

PolarPlot[Exp[ —] , {6, 0,8 7r}]
10

L'instruction échoue du fait de ce conflit de contexte! La bonne méthode est alors d'éliminer
PolarPlot du contexte Global avec Remove; Mathematica utilisera alors avec succes la définition
donnée par le package.

Remove [PolarPlot]
e

PolarPlot [Exp[ —]|, {6, 0, 8 n}]
10

Context[PolarPlot]

On voit, par la derniére instruction, qu'un des effets d'un Package est précisément d'introduire un
nouveau contexte pour les définitions de fonctions.

||—9—4) Nettoyage complet du contexte Global

Le cas d'erreur précédent était assez simple, car on connaissait explicitement la commande fautive.
Ce n'est pas toujours le cas, en particulier quand on a commis plusieurs erreurs dans un long
document. Les causes d'erreurs les plus fréquentes, outre I'appel d'une fonction avant d'avoir
chargé le package qui la définit, sont I'utilisation du signe égal simple pour écrire une équation, qui
introduit des définitions fausses, et I'utilisation du méme symbole pour une expression et une
fonction, sauf si celle-ci est définie comme une fonction pure.

f=2xx+1

flx_] := 1
+X

g=1Y3+x
g=m2+16&
gl2]

On peut donc étre amené a vouloir écraser toutes les définitions du contexte Global. Pour ceci, on
peut utiliser une syntaxe plus puissante pour Remove.

? Remove
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Les noms de tous les symboles définis par I'utilisateurs ont la structure (pattern) Global  nom. lIs
rentrent tous dans la famille Global" *, car * est le caractére qui, en informatique, représente toute
chaine de caractére. C'est le cas dans Unix et Dos, et dans pas mal de moteurs de recherche ou la
requéete burx vous donnera une réponse pour Durand, Durant et Duroc.

Cette syntaxe classique est reconnue par Mathematica, comme on le voit dans cette requéte
(stringMatchQ - qui n'est pas une fonction Listable -réponds a la question -o- de savoir si une
chaine de caractéres - string - corresponds - Match - a une structure)

StringMatchQ[#, "Durx"] & /@ {"Durand", "Dubois", "Duroc", "Duval"”, "Durant"}

Les instructions suivantes vous permettent de connaitre tous les noms que vous avez introduits (y
compris sans le vouloir, bien sar!) dans le contexte Global.

Names [ "Global ™ x"]

? Global™

g[3]

Et cette derniére instruction vous permet de toutes les effacer, sans quitter le Kernel

Remove["Global™ *"]

Names [ "Global ™ *"]

g[3]
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Physique avec Mathematica. Introduction
avancee.

l) Régles de substitution

I-1) Syntaxe des regles de substitution

Opérer une substitution dans une expression s'effectue avec la syntaxe ci-dessous. La
fleche est obtenue en tapant au clavier la série de touches = puis >

lexX4 —————— /. X> y
1- ax?

I-2) Pourquoi sont-elles importantes?

Ces structures sont si importantes qu'elles méritent une section entiére.

La premiére raison est qu'elles sont utilisées par de nombreuses fonctions (résolutions
d'équations, d'équations différentielles, recherches de minima, ...). Leur utilisation permet a Mathe-
matica de ne pas assigner de valeurs a des variables, ce qui pourrait perturber les calculs de
l'utilisateur, qui ne maitriserait plus l'introduction des variables. Voyons un exemple :

Clear[x]

Solve [a x2

+bx+c==0,x]
?x

La derniére instruction permet de vérifier qu'aucunevaleur n'a été assignée a x.
La deuxiéme raison de l'importance des régles de substitution vient des simplifications
formelles qu'elles autorisent. Nous le verrons a la question 1-4).

I-3) Comment utiliser des regles de substitution fournies par le logiciel?

Elles s'utilisent comme n'importe quelle régle de substitution, en prenant bien garde que le logiciel
en fournit une liste (sauf solution unique) dont il faut éventuellement prendre le bon élément.

1 1
solu = NSolve[x4 + —x3-"x - 1= 0]
3 4

solu[[3]]

Cette requéte permet d'obtenir une liste de nombres
x /. solu

Sin[x /. solu]

Log[x /. solu[[4]]]

Remarque : si vous étes vraiment mal a l'aise avec le logiciel, notez qu'il est toujours possible
d'utiliser un résultat comme entrée d'un calcul suivant par simple copier / coller, comme sur les
exemples ci-dessous :

Sin[0.9819830819514718" ]
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DSolve[{x'[t] = x[t], x[0] = 0.5}, x[t], t]

Plot[0.5  e*, {t, -1, 1}]

I-4) Comment utiliser des regles de substitution pour simplifier des
expressions?

Voyons deux exemples qui semblent particulierement simple

/.{'\/x_->a}
1-4/1-4/x
NE o+ —— /. [V > a)
Nx

Pourquoi la deuxiéme substitution a-t-elle échouée? Un cerveau humain repére instantanément la

structure 4/ x , et opére le remplacement de téte. Le logiciel ne travaille absolument pas comme

cela. Il travaille sur une représentation interne transmise par le FrontEnd au Kernel, en interpré-
tant les expressions tapées au clavier (voir TD N°1). On accéde a cette représentation interne par la
fonction FullForm, qui permet de comprendre d'ou vient I'erreur.

FullForm['\/x_]

1
FullForm['\/x +

]

Il'y a une régle simple pour effectuer des substitutions formelles sans risque d'échec :
TOUJOURS SUBSTITUER LE COMPLIQUE AU SIMPLE

X

Dans ce cas, plutdt que \/x — a, qui substitue & une expression "compliquée" \/; I'expression
simple "a", il faut faire x - a, et ensuite utiliser les fonctions de simplification du logiciel. C'est une
habitude a prendre, d'autant plus difficilement que, pour simplifier des expressions, notre cerveau
fonctionne exactement a l'inverse : il repére rapidement des structures compliquées, et les substitue
en bloc!

-

1

/. {x—»az}
b4

Simplify[%, a > 0]

Vous noterez que Mathematica est trés rigoureux : il sait que \/ a’ = asiet seulement sia > 0!

I-5) Exercices

Exercice I-1 :. Dans I'expression suivante, remplacer \/ u? -1 parA.

1 1
— 4[4+ u%-1 +Tan[—]
1+4u2-1 Yu?-1
Exercice I-2 :. Trouver la solution générale de I'équation différentielle y' = 2 — y°. Déterminer la
constante d'intégration lorsque y[0] = 1. Vérifier votre résultat par un calcul direct.
Exercice I-3 :. Trouver les racines du polyndme x® + 5x — x + 2. Contruire une table des puis-
sances 1 a 10 de la racine comprise dans l'intervalle [-1,0].
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Il) Fonctions pures. Fonctionnelles.

lI-1) Comment définir une fonction pure!?

Une fonction £[t] doit pouvoir se définir a I'aide d'une variable muette t. Par "muette”, on signifie
que le nom effectif de la variable n'a aucune importance : sin[t] et sin[u] définissent la méme
fonction.

La syntaxe de ce type de définitions est trés précise. Elle utilise le signe Deux points Egal
":=" la variable muette doit apparaitre dans le membre de gauche avec un caractére Under-
score " ", et sans underscore dans le membre de droite

(Au point de vue informatique, I'underscore est un filtre qui indique a Mathematica quels symboles
du membre de droite doivent étre considérés comme les arguments de la fonction)

flt_] :=
1+t2

Vous noterez que cette entrée ne provoque aucune sortie. Une fois définie, cette fonction permet
aussi bien le calcul de valeurs numériques que symboliques

£[3.]

3
f —
(5]
Plot[£f[u], {u, 0, 5}]
flyl
z
Solve[f[z] == —

2

Il existe une autre notation pour les fonctions, ne nécessitant pas de nommer les arguments. C'est
ce type d'expressions qui sont appelées fonctions pures.
Syntaxe : L'expression de la fonction doit étre terminée par une Eperluette "s", et les argu-

ments désignés par la touche Diése, suivie du numéro de I'argument : "s#1, #2, ... #n"
1
g= &
1+#12

glt]

g[3.]

g[V2]
Syntaxe : Les fonctions pures ont d'ailleurs une autre notation, moins compacte mais plus
explicite

1

h = Function[t, ] ;

1+t2
h[u]

h[3.]

lI-2) Qu'est-ce qu'une fonctionnelle? La fonctionnelle perivative.

Une fonctionnelle est une fonction dont les arguments sont eux-méme des fonctions. Un des exem-
ples les plus simple est la dérivée, notée en abrégée par un Prime ou de fagon équivalente
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Derivative[1l] [£f] [t]

£'[t]

Derivative[1l] [£f] [t]

On voit mieux que perivative est une fonctionnelle si on I'applique directement a la fonction, sans

spécifier son argument. Notez bien que £, tout comme g, représente une fonction pure, si l'on ne
spécifie pas son argument.

£

g9

lI-3) La fonctionnelle map.

Nous avons déja vu que certaines fonctions s'appliquent directement a des arguments sous forme
de liste. Elles ont comme attribut Listable,

Attributes[Sin]

(Les attributs de sin sont évidents a comprendre. Toutes les fonctions Mathematica ont I'attribut
"Protected", qui évite que I'utilisateur redéfinisse une fonction existante. On peut néanmoins le
faire, avec la commande uUnprotect. Son utilisation est bien entendu radicalement déconseillée! -
et ce, méme si une redéfinition ne prend effet que pour une session de travail donnée-)

Certaines fonctions n'ont pas cette propriété, comme cette fonction graphique (qui, pour étre
utilisée, necessite d'employer les fonctions show (affichage d'une sortie graphique) et Graphics
(création d'un objet graphique 2D))

Attributes[Circle]
Show[Graphics[Circle[{O, 0}, 1]], AspectRatio - 1]

Les fonctions définies sous forme de fonction pure ne sont pas "listables". La fonctionnelle Map
(aussi écrite /@), permet justement d'appliquer n'importe quelle fonction a une liste d'arguments. On
voit ci-dessous que la premiere requéte échoue, a la différence des suivantes :

«/1+n12 & {1, a, 0.5}
Map['\/1+n12 & {1, a, 0.5}]
\/1+n12 &/@{1, a, 0.5}

Comme application, un tres joli exemple (que j'emprunte au livre de J. Zizi, Mathematica pour
classes préparatoires) permettant de comprendre comment fonctionne la fonction plot.

Celle-ci est assez raffinée, car elle comporte des algorithme de recherche automatique de singular-
ités. Plus de points sont calculés lorsque la pente de la courbe évolue rapidement. Regardons un
exemple

x-1

£[x_] :=Abs[x-1] + Abs|

]

X

g =Plot[f[x], {x, -10, 10}]

Pouvez-vous comprendre la construction de l'instruction permettant de visualiser les points effective-
ment calculés?

Short [FullForm[g], 10]

Show[g /.Line[pts_] :» Point /@pts]
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Par ordre de difficulté croissante, il a fallu résoudre trois problémes.

(1) Comprendre, a l'aide de FullForm, que la fonction Plot représente le graphe de la fonction a
I'aide de la primitive graphique Line. Celle-ci, dont I'argument doit étre une liste ordonnée de points
(2 2 ou 3 coordonnées, selon que I'on utilise Graphics ou Graphics3D), trace une ligne joignant
successivement ces points.

(2) Savoir que pour les visualiser, il faut utiliser la fonction Point qui trace un point. L'argument de
cette fonction est une liste de deux ou trois nombres seulement, suivant que le point est dans un
espace a deux ou trois dimentions. C'est une fonction qui n'est pas Listable, il faut donc utiliser
Map ou /@ pour l'appliquer a chacun des éléments de I'argument de Line.

(3) Mais ce n'est pas tout! Il faut que dans la sustitution, Mathematica identifie la fonction Line,
mais aussi son argument pts, a l'aide du filire pts_. D'ou I'utilisation d'une regle de subsitution plus
subtile que d'habitude, codé avec || > . Cette régle identifie toute occurence de la fonction Line,
puis l'argument correspondant, et enfin remplace Line[pts] par Map [Point,pts] (ici codé
Points/epts)

lI-4) Fonctions pures comme solutions d'équations différentielles

Il est possible d'obtenir les solutions de bsolve sous la forme de fonctions pures. Si vous comparez
soigneusement la syntaxe de ces deux exemples, vous verrez qu'il faut prendre comme inconnue la
fonction y, sans spécifier la variable.

soll

DSolve[y''[t] + 0’ y[t] =0, y[t], t]

sol2 = DSolve[y''[t] + w’y[t] =0, y, t]

L'intérét d'avoir la solution sous forme de fonctions pures est que les regles de substitutions devien-
nent utilisables dans des fonctionnelles, qui s'appliquent a la fonction pure. En effet

y'[t] /. soll
y'[t] /. sol2
y''[t] + w?y[t] =0 /. soll // Simplify

y''[t] + w?y[t] =0 /. sol2 // Simplify

lI-5) Fonctions logiques

Mathematica peut travailler sur des variables logiques True (vrai) et False (faux)

And[True, False]

False

Or [True, False]

True

Il existe des fonctions a valeur logique, dont la principale utilisation est comme fonction pures, dans
des fonctionnelles. Nous allons étudier en détail la fonctionnelle select[], qui permet de sélection-
ner au sein d'une liste les éléments vérifiant un critére donné. Il existe toute une gamme de fonc-
tions logiques, de syntaxe générale FonctionQ, réalisant des tests. IntegerQ, par exemple, teste
si un nombre donné est un entier. Elle n'est pas Listable, nous utilisons donc la fonction Map

20 20
IntegerQ/@{3, 3., 71, 42,49, —, —}
4 3

{True, False, False, False, True, True, False}
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Elle peut étre utilisée dans select pour ne sélectionner que les arguments entiers de la liste ci-
dessus

20 20

select[{3, 3., xr, v/2, /9, —, —}, IntegerQ]
4 3

{3, 3,5}

La requéte suivante permet de connaitre toutes les fonctions de ce type
? *xQ

Dans select, on peut aussi construire sa propre fonction logique, comme dans I'exemple ci-
dessous

tabsin = Table[Sin[2 x i—] , {i, 0, 100}];
100

ListPlot[tabsin]

1 s,
I....— -.'-"l
0.5
20 40 . 60 80 100
-0.5
-1 .'"-..--".

ListPlot[Select[tabsin, #1 > 0 &]]

10 20 30 40 50

[1-6) Exercices

1

Exercice lI-1: Ecrire sous forme de fonction pure la fonction . En proposer un graphe, cal-

1-£2
culer sa dérivée puis sa primitive.
Exercice lI-2: Utiliser Map pour tracer 4 cercles concentriques, puis 4 cercles de méme rayon
centrés aux 4 coins d'un carré. (il faut construire une fonction pure a partir de la primitive circle)
Exercice lI-3:. Utiliser FullForm pour expliquer la raison des échecs des substitutions a la question
11-4)
Exercice lI-4:. Résoudre I'équation différentielle x> y" + xy' + (2 - xz)y = 0, puis vérifier la solution
obtenue par substitution.

Exercice lI-5:. Construire une liste des entiers de 1 a 10, puis sélectionner parmi eux ceux qui sont
premiers. Sélectionner ensuite ceux qui ne sont pas premiers. (Il existe une fonction qui vérifie
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qu'un entier est premier. Je vous laisse la trouver!)

lI-A) Appendice : Fonctions pures en notation postfix

N

Comme vous l'avez déja fait, il est possible d'utiliser des fonctions Mathematica avec une syntaxe
un peu inhabituelle, dite postfix (en Anglais, difficilement traduisible). Ainsi, les deux écritures
suivantes sont équivalentes

\E?
N[ —]
Nea

—//N
2

Cette écriture est trés commode pour deux raisons. D'abord, quand on souhaite appliquer une
fonction directement apres le résultat d'une autre (c'est typiquement le cas avec simplify), il est
beaucoup plus facile d'utiliser la syntaxe postfix qui permet de ne pas se tromper dans les crochets.
Ensuite, le résultat est souvent bien plus lisible que des fonctions imbriquées.

a a? ol
B B2 p3
Yy ¥ ¥

Det[

]

Simplify[%]

On peut préférer simplement

a a? a3
B B2 B3
y ¥ ¥

Det [ | 77 simplify

Ceci étant, comment faire s'il faut indiquer, toujours dans simplify, une option? Par exemple dans
ce calcul, ou Mathematica ne sait opérer une simplification que si on lui indique le signe de x?

I suffit d'introduire une fonction pure, correctement construite. Ainsi, les trois syntaxes ci-dessous
sont équivalentes, les deux derniéres utilisant les deux syntaxes possibles pour les fonctions pures

VN

// Simplify[#, x> 0] &

VE A
Va -

// Simplify

Simplify[ , X > 0]

X X
// Function[f, Simplify[£f, x > 0]]

VE

Si vous appréciez cette syntaxe, c'est une excellente utilisation des fonctions pures.

La fonction evaiuate

Une des utilisations standard de Mathematica est le travail sur des fonctions; il est souvent trés
pratique d'introduire des fonctions de plusieurs variables, ce qui permet de les représenter pour
différentes valeurs d'un parameétre. Comme exemple, nous allons étudier la fonction gaussienne
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gauss(x) =
24 ma

1 x?
gauss[x_, a_] 1= ——e 7=
24/ma

Plot[gauss[x, 1], {x, -8, 8}, Frame -» True]

l1l-1) Comment tracer cette fonction pour différentes valeurs du parametre a?

Essayons ce qui vient naturellement a I'esprit; vérifiez que cette commande n'est pas bonne.
4i )
Plot|[Table[gauss[x, —]|, {i, 1, 5}], {x, -8, 8}, Frame - True]
5

Pourquoi? Cela vient du fait que Plot commence par évaluer les valeurs de la variable (ici x), puis
seulement ensuite les valeurs prises par le premier argument pour ces valeurs de la variable. Si ce
premier argument est une fonction, ou une liste de fonctions données explicitement, tout marche
bien. Ici, la table n'est pas explicitée, et le tracé impossible. Il faut forcer I'évaluation du premier
argument avec la commande Evaluate

41i

Plot[Evaluate[Table[gauss[x, —] , {1, 1, 5}]], {x, -8, 8}, Frame -» True]
5

(dessin plus joli, avec les courbes en couleur)

Plot[Evaluate[Table[gauss[x, 4—1] , {i, 1, 5}]],
5

i
{x, -8, 8}, Frame » True, PlotStyle —>Table[Hue[—] , {1, 1, 5}]]
5

[11-2) Comment définir comme fonction la solution exacte d'une équation
différentielle?

solu = DSolve[{x''[t] + w?x[t] =0, x[0] =1, x'[0] = 0}, x[t], t]
Premier essai intuitif, mais qui ne donne pas le résultat.

f£[t , w ] :=x[t] /. solu[[1]]

£[2., 1.]

Trace[f[2., 1.]]

On comprend le probléme en utilisant Trace. En effet, la variable t est instantanément remplacée
par sa valeur numérique, et la substitution ne peut plus se faire.

Le probléme vient de ce que, lorsqu'on utilise une définition avec ": =", I'évaluation du mem-
bre de droite n'est pas faite lors de la définition de la fonction, mais seulement lorsqu'une requéte
demande explicitement un calcul. Il est donc possible d'éviter cet inconvénient en utilisant la fonc-
tion Evaluate dés la définition initiale.

f[t_, w_] := Evaluate[x[t] /. solu[[1]]]
f[2., 1.]
Trace[f[2., 1.]]

Une autre solution, d'ailleurs plus simple, consiste a définir la fonction sans utiliser I'évalutation
différée, c'est-a-dire en utilisant le simple signe "=" plutét que ":="
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glt_, w_] =x[t] /. solu[[1l]]

g[2.,1.]

Trace[g[2., 1.]]

111-3) Comment définir comme fonction la dérivée d'une fonction?

De fagon peut-étre surprenante, le probléeme se pose exactement dans les mémes termes lorsqu'on
veut définir comme fonction une dérivée. Mathematica sait parfaitement calculer des dérivées.
Reprenons notre gaussienne, et proposons nous d'en tracer la dérivée.

dpgauss[x_, a_] := O0x gauss[x, a]
dpgauss[2., 1]

Cette définition échoue, car les variables sont remplacées par leurs valeurs numériques, et ce n'est
qu'ensuite que Mathematica cherche a effectuer la dérivation. Le probléme se régle comme
précédemment, en forcant I'évaluation. Celle-ci est alors faite dés la définition de la fonction, et c'est
dans le résultat que les valeurs viennent remplacer les variables.

dpgauss[x_, a_] := Evaluate[dx gauss[x, a]]
dpgauss[2., 1]
Plot[dpgauss[x, 1], {x, -8, 8}, Frame -» True]

Cette méthode n'est pas la seule. En effet, I'opération de dérivation (ou de dérivation partielle) est
une fonctionnelle, et si on écrit explicitement la forme fonctionnelle on ne rencontre pas de prob-
[&éme. On aurait ainsi pu écrire

dpgaussbis[x_, a_] := Derivative[l, 0] [gauss] [x, a]
dpgaussbis[2., 1]
Plot [dpgaussbis[x, 1], {x, -8, 8}, Frame -» True]

Il est possible d'utiliser une syntaxe trés condensée, équivalente aux notations mathématiques
standard, pour une fonction d'une seule variable. Dans ce cas en effet, la notation £' (resp. £'"',
£''', efc...) est synonyme de Derivative[1l] [£] (resp. Derivative[2] [£],

Derivative[3] [£]). Les dérivations ainsi notées sont effectuées sur les fonctions pures, et leur
argument n'est évalué qu'apres. Les définitions ci-dessous fonctionnent donc parfaitement.
Syntaxe : Attention, £'' est écrit avec les touches f-> Prime -> Prime (et NON f -> Double
prime)

g[x_] :=gauss[x, 1]
dg[x_] :=g'[x]
ddg[x_] :=g"''[x]

Plot[{g[u], dg[u], ddg[u]}, {u, -8, 8}, PlotStyle »
{RGBColor[1l, 0, 0], RGBColor[O, 1, 0], RGBColor [0, O, 1]}, PlotRange -» All]

l11-4) Comment représenter graphiquement la solution numérique d'une
équation différentielle?

La encore, dans Plot, il faut forcer I'évaluation de la solution numérique. C'est du moins ce qui est
indiqué dans le manuel, mais ne semble pas se produire...
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solu = NDSolve[{y ' [x] = Sin[y[x]], ¥[0] == 1}, ¥, {x, O, 4}]

Plot[y[t] /.solu, {t, 0, 4}]

l11-5) Exercices

Exercice lll-1 : Tracer les solutions de I'équation différentielle x ' - x + a x? = 0, x(0) = 1 pour
plusieurs valeurs du paramétre a (cette équation a une solution analytique) entre 0 et 1.

1

Exercice llI-2 : Définir une fonction qui soit la primitive de T

En donner une représentation

graphique.
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Utilisation des fonctions graphiques

. Lignes de champ et équipotentielles d'un dipdle
electrique.

Le potentiel au point M exercé par un dipdle p, orienté selon I'axe Oz, est

1 pcosé@
v 6) = Amey  r2

La figure suivante définitret 6 :

<< Graphics Arrow"

7T
¢ = —Random[];
4

Show|[Graphics [ {Arrow[{-0.5, 0}, {0.5, 0}],
Disk[{1.5Cos[¢], 1.5Sin[¢]}, 0.05], Line[{{0, O}, {1.5Cos[¢], 1.5Sin[¢]}}],
{pashing[{0.05, 0.05}], Line[{{0.5, 0}, {1.5, 0}}]}, Circle[{O, O}, 1, {0, ¢}],
Text["p", {0.5, 0.1}], Text["r", {Cos[¢] -0.1, Sin[¢]}],

Text|["6", 1.1 {Cos[g], Sin[g]}], Text["M", 1.6 {Cos[¢], Sin[¢]}],
2 2

Text["0", {0, -0.1}], Text["z", {1.6, 0}]}], AspectRatio - Automatic];

M

p
— —

o
[-1) En déduire les composantes du champ électrique. Deux remarques :
(1) éviter absolument la notation E qui une notation interne a Mathematica, la base de I'exponen-
tielle.
(2) réfléchissez, faites attention a n'introduire aucune constante superflue!

rdé

[-2) Trouver la forme des lignes de champ, dont I'équation est (pourquoi ? ) % =3
r 0

I-3) Tracer sur le méme graphe le dipéle, quelques lignes de champ et quelques équipotentielles
(ces derniéres en pointillé). L'instruction ci-dessous permet de représenter le dipble lui-méme
comme une fleche.

<< Graphics Arrow"

Plusieurs possibilités. D'abord avec la fonction ParametricPlot, ensuite en chargeant un package
graphique, et en utilisant une fonction PolarPlot

<< Graphics~Graphics™

I-4) Vérifier qu'équipotentielles et lignes de champs sont orthogonales. (la solution est naturellement
donnée sous la forme d'une courbe en coordonnées polaires; il est néanmoins assez simple de la
transformer en une courbe paramétrée par I'angle 6)
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|l. Diffraction d'une onde plane normale par un trou
circulaire de rayon a

Dans I'approximation de Fraunhoffer, dite aussi "diffraction a l'infini", I'amplitude de la vibration
lumineuse [scalaire, a cette approximation; I'amplitude incidente dans le plan diffractant 1 est S(x,
y) ]transmise par un écran diffractant 1 [supposé plan, lié a un repére (O, x,y)] de facteur de trans-
mission t(x,y), dans la direction (a,), est donnée a une constante multiplicative prés par

S(a, B) “ffl‘l t(x, y) S(x, y) exp[-I &= (ax + By)]dxdy

Si (X,Y) sont les coordonnées d'un point de I'écran d'observation, L la distance de cet écran a I'objet
diffractant, on a bien sir a= )Li = %

[I-1) En quel systeme de coordonnées faut-il se placer ? Pourquoi ne perd-on pas en généralité en
posant 8 =0 ? Exprimer I'argument de I'exponentielle dans des variables plus appropriées.

[I-2) Exprimer l'intégrale ci-dessus et la calculer lorsque I'onde incidente est une onde plane sous
incidence normale (soit S(x,y) = 1). Attention : il faut forcer Mathematica a commencer par intégrer

sur la variable angulaire.
aa

Simplifier le résultat en introduisant la variable =u

. . . . A . ,
I1-3) Calculer le rayon angulaire a de la tache centrale de diffraction en fonction de 5. Ceci néces-

site la recherche numérique de racines d'une équation. Il est vivement conseillé de commencer par
une représentation graphique.

[I-4) Représenter comme DensityPlot[] la figure d'interférence en intensité. (on pourra jouer sur
les options pour améliorer la figure)

[1-5) Calculer le rapport entre I'énergie lumineuse contenue dans le premier et le deuxi€éme anneau,
et celle contenue dans la tache centrale (commencer par la recherche numérique des racines
nécessaires)

1. Diffraction d'une onde plane normale par un demi-
plan a I'approximation de Fresnel

Nous allons nous intéresser a la géométrie la plus simple que I'on puisse envisager : la diffraction
par le demi-plan y > 0 d'une onde plane sous incidence normale. Nous prendrons Ox dans le plan,
Oz perpendiculaire au plan. Le probléme ne dépend clairement pas de x, et I'amplitude du champ a
une distance z, au point Y, est donnée par

_ RARPNRVY
um = ["exel1 = -7 dy
En posantv -V = / AZ—Z (y - Y), on obtient U(V) = CF(c0) + CF(V) + | (SF(c0) + SF(V)) ou on définit

T 2 7T 2
CF (V)= Cos[—u ]dlu, SF(V) = Sm[—u ]cﬂu
0 2 0 2

Ces fonctions spéciales sont appelées intégrales de Fresnel. Mathematica les connait :

A’ '
{j cos[ = u?] du, j sin[ = u?] du}

0 2 0 2
{FresnelC[V], FresnelS[V]}

[1I-1) Calculer les valeurs en +, ainsi qu'un développement limité a I'origine (de deux fagons
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différentes)

[1I-2) Représenter la courbe paramétrique (FresnelC[V],FresnelS[V]). En déduire une interpréta-
tion géométrique de la formule de diffraction de Fresnel par un demi-plan.

[1I-3) Représenter l'intensité lumineuse | U(v) |2. Quelles sont les différences avec I'optique
géométrique ?

IV.Vibrations d'une membrane circulaire

Le systeme physique est une membrane, parfaitement élastique, uniformément tendue avec une
tension T par unité de longueur. On note o la masse surfacique de la membrane. Enfin, on suppose
qu'elle est attachée a un contour circulaire rigide.

On s'interesse aux déformations transverses, en régime linéaire, de la membrane. Définissons un
repere (O,x,y,z) tel que (O,x,y) soit confondu avec le plan de la membrane au repos, et (Oz) perpen-
diculaire. Le point (x,y) se trouve a la position z = W(x,y,t), et la dynamique des déformations trans-
verses est décrite par I'équation

AY - Z9,¥ =0,

N T . P . . .
oucs / - est la vitesse des ondes transverses, et A représente le Laplacien en deux dimensions.

Il est naturel, vue la géométrie des conditions aux limites, de se placer en coordonnées polaires.
L'équation est alors
BrrM(r, 6, ) + L0, W(r, 6, 1) + T 060W(r, 6, 1) - T8, ¥(r, 6, 1) = 0
La méthode de résolution consiste a chercher une solution sous la forme W(r,0,t) = R(r) ©(6) e,
2

. w . Y
Si on pose — = k?, on aboutit a
c

r2

—(R" (1) + 1—R'(r)) c K= -— 0" (6) = Cste
R(r) r o(6)

r et 6 étant deux variables indépendantes, les deux fonctions prennent des valeurs indépendantes
et ne peuvent étre toujours identiques que si elles sont égales a une méme constante.

IV-1) En étudiant I'équation pour la fonction ©(8) de la variable angulaire 8, exprimer pourquoi la
constante doit étre positive, égale & m?ou m est un entier naturel.

IV-2) En déduire I'équation vérifiée par R(r). Cette équation est I'équation de Bessel. La résoudre
pour m = 0. Les solutions doivent étre valables dans tout le domaine 0 <r < a, si a est le rayon de
I'anneau sur lequel la membrane est tendue. Nous allons donc nous intéresser au comportement
des deux fonctions de Bessel prés de l'origine r = 0. Tracer Jo(r) et Yo(r) (que Mathematica note
BesselJ[0,r] et Bessel¥Y[0,r]) Que suggére ce dessin? Vérifier votre hypothése en faisant un
développement en série au voisinage de r = 0. En déduire la valeur d'une des constantes
d'intégration.

IV-3) Etudier ensuite lescasm=1etm=2.

IV-4) Quelle est la condition aux limites en r = a ? En déduire que seules certaines valeurs de k a
sont possibles. Ces valeurs discrétes définissent les modes propres de la membrane, qui sont donc
indexés par deux nombres entiers, m définit précédemment et n le numéro de la racine k a. Calculer
numeériquement les valeurs de ka pour les modes (0,1), (0,2), (1,1) et (2,1).

IV-5) Représenter graphiquement, en donnant a chaque figure le titre (m,n), les modes (0,1), (0,2),
(1,1) et (2,1). Le dessin le plus clair utilise la fonction bensityPlot[]; il est plus joli aussi d'utiliser
la fonction GraphicsArray[].

I faut réfléchir un peu a la fagon dont fonctionne pensityPlot[]. Cette fonction trace au point de
coordonnées cartésiennes (x,y) un pixel d'un niveau de gris fixé par la valeur f(x,y) de la fonction,
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dans un domaine rectangulaire. Dans le cas présent, la fonction est donnée pour des variables
(r,0); pensez a convertir les coordonnées! Pour r c'est facile, pensez a définir proprement une
fonction 6[x,y]. Par ailleurs, la fonction est a tracer dans un domaine circulaire; on peut utiliser une
fonction 1£[], ou la fonction logique Boole[], disponible a partir de la version 5 de Mathematica..

IV-6) Construire une table fournissant les 4 premiers modes pour m =0, 1 et 2. La meilleure descrip-
tion consiste a fournir les fréquences propres, par rapport a celle du mode fondamental (Rq : il est
utile de commencer par une représentation graphique des fonctions, et d'en déduire une fagon
automatique de recherche des modes)
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Oscillateur harmonique libre et force. Filtres
analogiques.

I-1) Oscillations libres d'un circuit RLC

I-1-a) Obtenir le schéma ci-dessous (facultatif).

NB 1 : La notation r pour la capacité n'est pas choisie au hasard, ¢ est une notation interne a
Mathematica, qu'il faut donc éviter. (c'est le nom des constantes d'intégration)

<< Graphics Arrow"

1
gl = ParametricPlot[{¢—0.5 Sin[27¢], — -0.5Cos[2 7r¢]},
27

1 19
{d), -, —} , Axes - None, DisplayFunction - Identity] ;
4 4

Xo=¢-0.58in[27¢] /. {¢ > 0.25};

1
Yo= — -0.5Cos[27¢] /. {¢ > 0.25};
27

X1=¢-0.58in[27¢] /. {¢ > 4.75};

1
Y= —-0.5Cos[27¢] /. {¢p » 4.75};
27

Show|[{gl, Graphics[{Arrow[{Xo -5, Yo}, {X0-2, Yo}],
Line[{{Xo -2, Yo}, {Xo, Yo}}], Line[{{X1, Y1}, {X1+2, Y1}}],
Line[{{X1+5, Y1}, {X1+7, ¥1}}], Line[{{X1+2, ¥1-0.5},
{X1+2, ¥1+0.5}, {X1+5, ¥, +0.5}, {X1+5, ¥1-0.5}, {X1+2, ¥,-0.5}}],
Line[{{X1+7, Y1}, {X1+7, ¥Y1-3}}], {AbsoluteThickness[2],

Line[{{X1+6, ¥Y1 -3}, {X1+8, ¥Y1-3}}], Line[{{X1+6, ¥1 -4}, {X1+8, ¥Y1-4}}]1},
Line[{{X1+7, ¥Y1-4}, {X1+7, ¥Y1-7}}], Line[{{X0o-5, Y1 -7}, {X1+7, ¥1-7}}1,
Arrow[{Xo-4.5, Y1-6.5}, {X0-4.5, ¥Y0-0.5}], Text["I(t)", {X0-3.5, Yo+1}],
Text["L", {(Xo+X1) /2, Yo+1}], Text["R", {X1+3.5, Yo+1}],

Text["T", {X1+9, Y0-3.5}], Text["U(t)", {Xo-3, ¥Y0-3.5}1}1},
DisplayFunction » $DisplayFunction, AspectRatio » Automatic,
PlotRange - All];

THEL L R
UHtL G

I-1-b) Adimensionalisation de I'équation

Soit q(t) la charge électrique du condensateur. L'équation différentielle du circuit, en régime libre
(U(t) = 0) est

R 1
O0q+ —0tq+ —q=0
L LT
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1
Il est interessant de faire apparaitre une pulsation w® = L—I_et de poser n = E Z . Quelle est sa

dimension physique ? Quelle est sa signification physique ? Attention a faire les substitutions dans

le bon ordre!
Fonctions a utiliser : substitutions de variables, et Simplify

I-1-c) Résoudre cette équation avec comme condition initiale q(0) = I, q'(0) =
0. Simplifier le résultat en introduisant un temps adimensionné 7= w t.

Physiquement, cette situation correspond a un condensateur initialement chargé.
Fonctions a utiliser : DSolve

I-1-d) Définir une fonction charge[t,n] qui représente la charge aux bornes du
condensateur, et la tracer pour N < |, n=1 et n>1I (trois couleurs
différentes pour chacune des courbes). Comment traiter le cas n = 1| ?

Fonctions a utiliser : bsolve, Plot en spécifiant PlotStyle avec RGBColor

I-1-e) Montrer qu'en régime pseudopériodique le signal est encadré par deux
fonctions exponentielles décroissantes.

La forme dont on dispose pour la solution est fort peu pratique. Le but du calcul est de mettre la
solution sous la forme

A Cos[\/ 1-% 1+ d)]e"”
ou A est une constante.

La simplification est difficile a obtenir, car la forme finale souhaitée comporte a la fois une fonction
trigonométrique et une fonction exponentielle. Une bonne méthode est de multiplier la fonction a
simplifier par " t. Ensuite, un bon moyen d'utiliser le fait que n < 1 est de poser n = Sin[¢], avec
0<¢< ’zl puisque n > 0. Repasser a une expression dépendant de n a la fin du calcul.

Fonctions a utiliser : substitutions de variables, Simplify, ExpToTrig, TrigToExp

I-1-f) Représenter le signal et ses enveloppes sur un graphe. Calculer la
position de quelques maxima de la fonction. Pourquoi appelle-t-on ce régime
pseudopériodique ? Quelle est la valeur de la pseudo période ? Est-ce
conforme a I'expression trouvée pour la solution ? Les maxima sont-ils
confondus avec les points de contact entre la courbe et son enveloppe
positive ? (ceci pour une valeur quelconque de n, 0 < n < |, c'est-a-dire une
valeur quelconque de @)

Le but de I'exercice est de faire la recherche de maxima automatiquement, et d'en obtenir une liste

(que l'on notera tabmax).
Fonctions a utiliser : Table, FindMinimum

I-2) Oscillations forcees

I-2-a) On s'interesse a la résonance de charge. La tension aux bornes du condensateur est reliée a
la tension U(t), supposée sinusoidale de pulsation Q par UC = H(Q)U. Ona
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1

H(Q) = 1
1Qr(ILQ + R+ )

Calculer module et argument de H(Q), en fonction des paramétres sans dimension précédents n et
w, ainsique de v = % En donner une représentation graphique pour n=0.1, 0.25 et 1.

NB : Pour les calculs formels avec des complexes, il est vivement recommandé de charger le
package Algebra~ReIm™, qui permet en particulier de déclarer qu'un symbole est réel. Les instruc-
tions sont tapées ci-dessous, bien retenir leur syntaxe. En outre, Mathematica sait, pour cette
formule déja compliquée, calculer partie réelle et imaginaire, mais pas directement module et
argument.

Fonctions a utiliser : complexExpand (utiliser I'option TargetFunction), Plot (tracer les courbes
en couleur), GraphicsArray, Which ou If (ces derniéres pour représenter de fagon convenable
la phase)

Facultatif : vous pouvez jouer avec I'option bisplayFunction, pour éviter des sorties graphiques
inutiles. 1l est aussi plus agréable, pour la phase, d'avoir les ordonnées en sous-multiples de 7.

<< Algebra ReIm"
T'/:Im[I'] =0; Q/: Im[Q] =0; R/: Im[R] =0; L /: Im[L] = 0;

[-2-b) Calculer la pulsation a la résonance, ainsi que la bande passante du filire RLC. Jusqu'a quelle
valeur de n peut-on parler de résonance? Lorsque la dissipation est faible (en un sens qu'on précis-
era), calculer la pulsation a la résonance, I'amplitude de la résonance et la bande passante, au
premier ordre.

Fonctions a utiliser : solve, Series

Il - Chaines de quadripoles

lI-1) Obtenir le schéma ci-dessous (facultatif) .

Nous allons étudier dans cette partie des quadripdles passifs, selon le schéma suivant dit "forme en
T

Le but de cette question est d'utiliser des fonctions graphiques pour réaliser un dessin. Les
fleches nécessitent le chargement d'un package graphique.
Fonctions a utiliser : Graphics, Line, Text, Arrow

<< Graphics Arrow™
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Show[Graphics[{Line[{{0, 0}, {2, 0}, {2, 1}, {4, 1}, {4, -1}, {2, -1}, {2, 0}}1,
Text["Z2", {3, 0}], Line[{{4, 0}, {6, 0}}],
Line[{{O, O}, {-2, O}, {-2, 1}, {-4, 1}, {-4, -1}, {-2, -1}, {-2, 0}}],
Text["Z.", {-3, 0}], Line[{{-4, 0}, {-6, 0}}],
Line[{{o, o}, {0, -2}, {1, -2}, {1, -4}, {-1, -4}, {-1, -2}, {0, -2}}],
Text["Z3", {0, -3}], Line[{{0, -4}, {0, -6}}], Line[{{-6, -6}, {6, -6}}],
Arrow[{-5.8, -5.8}, {-5.8, -0.2}], Text["u1", {-6.2, -3}],
Arrow[{5.8, -5.8}, {5.8, -0.2}], Text["u2", {6.2, -3}],
Arrow[{-6.5, 0.4}, {-4.5, 0.4}], Text["i1", {-5.5, 1}],
Arrow[{4.5, 0.4}, {6.5, 0.4}], Text["i2", {5.5, 1}1}1,

AspectRatio -» Automatic, PlotRange -» All];

i ip

(R —_—

I | B \

Il - 2) Obtenir , sous forme matricielle, la relation entre les variables d' entrée
et de sortie

B ( a b )
~\ec d
Que vaut le déterminant de la matrice ? (C' est un résultat remarquable, qu' on peut démontrer par

des considérations énergétiques pour des impédances non dissipatives, ou comme ici a partir des
lois de mailles et noeuds)

uz
i

uz
i

Il faut écrire la matrice automatiquement, a partir des lois de Kirchoff.

Fonctions a utiliser : solve, Coefficient, MatrixForm, Det

Remarque : l'utilisation de Solve est inhabituelle. En effet nous avons trois équations, pour cing
inconnues! Il faut donc préciser quelle variable doit étre éliminée, et quelles variables doivent étre
exprimées en fonction des inconnues restantes.

Remarque 2 : Il y a une fagon trés astucieuse d'utiliser la fonction coefficient pour avoir directe-
ment la matrice cherchée, en utilisant la fonction outer, dont je vous donne ci-dessous un exemple
d'utilisation.

Outer[f, {a, b}, {c, d}]

{{fla, c], fla, d]}, {f[b, c], f£[b, d]}}

lI-3) Impédance itérative.

On ferme le quadripdle par une impédance Zy, de telle sorte que Zy = uz/i. Montrer qu'il est possi-
ble de choisir Zpde sorte que cette impédance soit itérative, c'est-a-dire qu'on ait Zy = uq/i;. Exam-
iner le cas particulier z, = 2, = Z3 = Z, et en conclure qu'une seule de cas valeurs a un sens
physique.

l1-4) Quelques exemples de filtres. (tous les composants sont supposés
parfaits)

Ill-4-a) Z4et Z,correspondent a la méme inductance L, et Zsest réalisée par une capacité 2T.
Montrer que, si I'on ferme le quadripdle sur son impédance itérative, on construit un filtre passe-bas.
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(Mathematica simplifie les radicaux avec difficulté; il est plus simple de travailler sur Zo(w)?)
Tracer Zp(w) ou w est la pulsation (Afin de comparer entre eux ces trois filtres, on les tracera sur le
méme graphe, en fonction de la méme fréquence sans dimension).

1

L'adimensionalisation se fera, ainsi que dans les questions suivantes, en posant w= | — v pour
LT
ce qui est des fréquences. Pour l'impédance Zy?, I'adimensionalisation se fait ici en multipliant par
27
L

r
[lI-4-b) Zyet Zocorrespondent a la méme capacité 5 et Z;est réalisée par une inductance L. Montrer

que I' on construit un filtre passe-haut. Pour l'impédance Zy?, I'adimensionalisation se fait en multipli-

r
ant par —.
2L

[1I-4-c) Montrer que I'on construit un filtre passe-bande en prenant Z= Z,constituées d'une induc-
tance L en série avec une capacité I', et Zsconstituée de la méme inductance L en paralléle avec la
méme capacité . Tracer Zy(w). Calculer la bande passante du filtre. Pour Iimpédance Zy?, I'adimen-

r
sionalisation se fait en multipliant par Z
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Pendule pesant tournant

A. Pendule pesant.

Le systéme que nous étudierons est une bille, assimilée a une masse ponctuelle m, coulissant sans
frottements le long d'un anneau circulaire rigide de rayon R.

Dans toute la partie A, cet anneau est immobile dans le référentiel du Laboratoire, que nous sup-
poserons Galiléen. On note g I'accélération de la pesanteur, I'axe OZ est supposé vertical, orienté
vers le haut.

Le systéme peut étre schématisé comme ci-dessous.

<< Graphics Arrow"

T
= — % Random|[];
4
Show|[Graphics[{Circle[{0, 0}, 1],
3
Circle[{0, 0}, 0.5, {—, 2x-6}], Arrow[{0, -1.2}, {0, 1.2}],
2

{Dashing[{0.025, 0.025}], Line[{{0, 0}, {Cos[6], -Sin[6]}}1},
Disk[{Cos[©], -Sin[©]}, 0.05], Text["m", {Cos[©] +0.2, -Sin[6]}],
Text["2", {0.1, 1.1}], Text["O", {-0.1, -0.1}],

Text[“e" , 0.6 {Cos [ % - 3] , Sin[ 74_7r - ;] }] }] , AspectRatio - Automatic] ;

A,

A.lI- Mise en équation

La méthode la plus rapide est de passer par les équations de Lagrange. Soient donc E ¢I'énergie
cinétique, Epl'énergie potentielle, L le Lagrangien et enfin H I'Hamiltonien.

Ec = 1mRz (0r ©[t])2; Ep=mgR (1-Cos[O[t]]);
2

Il est préférable d'utiliser une variable temporelle sans dimension, 1= | % t. Cela élimine des

parameétres inutiles, et par ailleurs permet de mieux distinguer le comportement de l'oscillateur en
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régime linéaire et non linéaire.

L--gmR [1—Cos[¢[\/§t]]]+ :—mRZ [atqb[\/?t]

L=L/(mgR) // Simplify

/. gt->1:;
R

8c 8o, ¢c] L - Ope L

L'équation du mouvement est donc

" = -Sin[¢]
et 'unité d'énergie est m g R. Désormais, toutes les énergies seront exprimées dans cette unité. Le
Hamiltonien vaut

B = 0: ¢[t] (aatda[:] f-) -L

C'est une constante du mouvement puisque le Lagrangien ne dépend pas explicitement du temps.
Dans ce cas simple, son interprétation physique est trés claire : il s'identifie a I'énergie totale de la
particule, dans le référentiel (galiléen) du Laboratoire.

All- Oscillations d'amplitude finie

A.ll-1) Soit E I'énergie mécanique de la bille . Tracer I'énergie potentielle 0(6), et montrer que pour
E < Enax (Qu'on précisera) la bille effectue des oscillation d'amplitude A. Mettre en évidence sur le
dessin I'énergie cinétique du pendule pour un angle quelconque ¢ < A, par une droite en pointillés.
Donner A en fonction de E. Quel est le mouvement de la bille lorsque E > Eqnax ?

A.lI-4) Portrait de phase de l'oscillateur. L'espace des phase est le plan (¢,¢'), et faire un "portrait
de phase" consiste a tracer quelques trajectoires dans cet espace de phase. On tracera 4 trajec-
toires, dont une en régime linéaire (¢p<<1 et Sin[¢]~¢), une dans le cas E < Epax, Une pour E >Epax
et enfin E = Enax. On utilisera avec profit les propriétés de symétries des trajectoires.

A.lll) Période des oscillations en fonction de leur amplitude.

Lorsque I'amplitude des oscillations est infinitésimale, leur période est indépendante de I'amplitude :
c'est l'isochronisme des petites oscillations. Pour une amplitude finie, il n'en est plus ainsi. A partir
de I'expression du Hamiltonien, la période peut se mettre sous la forme

1
T=4r de
°* J2 JE - 1+Cosig]

et I'énergie E est reliee a I'amplitude maximale A par E = 1 - Cos[A], soit
1
T=22 de
® |/ Cos[6] - Cos[A]

Sous cette forme, Mathematica (en version 4.2!) ne sait pas calculer l'intégrale, il faut donc faire des
changements de variable.

Dt [6]

/. {A-> 2ArcSin[k]} // Simplify

4/Cos[6] - Cos[A]

Il faut ensuite effectuer le changement de variable ci-dessous. Il est indispensable de préciser que k
doit étre considéré comme une constante. Il faut aussi utiliser Fullsimplify, avec les bonnes
hypothéses (pour information, on donne le résultat sans ces hypothéses)

SetAttributes [k, Constant]
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Dt[e
6] /. {6 > 2ArcSin[k Sin[¢]]} // FullSimplify

\/-1+2k?+cos[6]

Dt[e] /. {6 > 2ArcSin[k Sin[¢]]} //

\/-1+2k?+cos[6]

7T
FullSimplify[#, 0<k<1&80<¢< —| &
2

Reste a transformer la borne d'intégration!

Solve[(A /. {A - 2ArcSin[k]}) == 2 ArcSin[k Sin[¢]], ¢]

On peut alors calculer l'intégrale, et revenir a la variable A

T 2

a¢ /. {k—»sin[zzi]}

22

° \2-2k?sin[¢]?

A.lll-1) Tracer le graphe de la période en fonction de A. Que vaut la période pour A = 0? Mettre en
évidence la divergence logarithmique de la période pour A - 7T.

A.llI-2) Obtenir les trois premiers termes du développement en puissances de A de la période.
Commentez le résultat.

B. Anneau en rotation.

Désormais, I'anneau tourne a la vitesse angulaire constante w dans le référentiel du Laboratoire.

Mise en équation

Cette fois, les équations de Lagrange sont de loin les plus pratiques pour trouver I'équation du
mouvement. Nous prendrons la méme unité de temps que précédemment, et on introduira la

fréquence sans dimension Q = w / 'gi

Ec = lmRZ ((6c ©[t])? +w? Sin[6[t]]%); Ee =mgR (1-Cos[6[t]]);
2

L=-gmR [1—Cos[¢[\/§t]]]+
imRz [w2 sin[¢[\/§t]]2+ [atd’[\/gt]]z] /. \/g""tf

L=L/ (mgR) // Simplify

L=L/.{w—>Q\/§}

Oc 95, ¢[c] L - Op[z] L // Simplify
L'équation du mouvement est donc
¢”[t] =-(1-Q*Cos[¢[T]]) Sin[¢[T]]
B.I- Positions d'équilibre. Bifurcation fourche

B.I-1) Quelles sont les positions d'équilibre de la bille lorsque I'anneau est en rotation ? Déterminer
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leur stabilité en linéarisant I'équation du mouvement au voisinage de la position d'équilibre.

B.1-2) Représenter sur un graphique les positions d'équilibre en fonction de Q, en traits pleins (resp.
pointillé) pour les positions stables (resp. instables). Montrer qu'au voisinage de la bifurcation la

nouvelle position d'équilibre varie comme la racine carrée de I'écart au seuil : A « w/ Q-1.

B.1-3) Représenter I'évolution de la période d'oscillation de la bille autour d'une position d'équilibre
stable, en fonction de Q. Etudier le comportement asymptotique prés de la bifurcation.

B.Il Etude énergétique

Le Hamiltonien du systéme se calcule sans difficulté.
H = 0; ¢[t] (8o, 4[r) L) -L // Simplify

C'est une constante du mouvement, puisque le Lagrangien ne dépend pas explicitement du temps.
Cependant, son interprétation physique est moins simple que dans le cas du pendule simple : il ne
s'agit pas de I'énergie totale dans le référentiel du Laboratoire, mais de I'énergie dans le référentiel
(non galiléen) mobile lié au cerceau.

On définit une nouvelle énergie potentielle :

Ul _, Q] := L (2-2cos[¢] -Q* sin[4]?)
2

B.1l-1) Représenter celle-ci en fonction de ¢, pour différentes valeurs de Q (avant, a et aprés la
bifurcation). Retrouver les conclusions précédentes sur la stabilité des positions d'équilibre. Calculer
le développement limité de I'énergie potentielle a la bifurcation U[¢,1] au voisinage de ¢ = 0.
Commentaire?

B.1I-2) Tracer un portrait de phase de l'oscillateur, aprés la bifurcation (une "bonne" valeur est Q =
3). On tracera en gras les trajectoires passant par les points d'équilibre instables (¢ = 71, ¢' = 0) et
(¢ =0, ¢' = 0), qui sont appelées séparatrices (voyez-vous pourquoi?). On tracera ensuite des
trajectoires correspondants aux autres cas (a l'intérieur de la premiére séparatrice, entre les deux, a
I'extérieur).
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Oscillations non-linéaires

A) Développement asymptotique : Introduction.

A-1) Impossibilité d'un développement "naif"

L'équation différentielle 8"[t] + Sin[#[t]]==0 n'a pas de solutions exactes (sauf en terme de fonctions
spéciales) pour une amplitude 8 quelconque (non infinitésimale). Une stratégie naturelle est d'es-
sayer de trouver une solution a amplitude faible, sous forme d'un développement en série. Nous
introduirons explicitement un petit paramétre e,

o[t] = eol[t] +e262[t] + €®63[t]

On parle de développement asymptotique, car a la différence d'un développement en série de
Taylor, ou en série de Fourier, il n'existe en général pas de théoréme assurant la convergence de
ce type de développement. On espére juste (et on constate en pratique!) que les termes sont de
plus en plus petits, 61 [t] > 62[t] > ©3[t].

6t,t9[t]
Series[-Sin[O[t]], {€, 0, 3}]

Si l'on veut transformer ce développement en série en un polynome en €, pour en extraire par
exemple les coefficients, il faut appliquer la fonction Normal

poly = Normal[%];

Coefficient[poly, €, 2]

Essayons alors de résoudre I'équation a I'ordre €. Comme condition initiale, nous prendrons
©[0]=€, ©6'[0]=0,s0it6e1[0]=1, 6n[0] = Opourn > 1, én'[0]=0.

solun = DSolve[{61”[t] + ©1[t] =0, 61[0] == 1, 61'[0] == 0}, 61[t], t]

Jusque I3, tout va bien puisqu'on trouve la solution pour une amplitude infinitésimale. On espére
que les termes d'ordre suivant vont apporter une petite correction, valable pour € petit mais non
strictement infinitésimal.

Le calcul de I'ordre €2n'apporte rien, car le premier terme non linéaire provenant du Sinus est
cubique. Vérifions le quand méme!

DSolve[{62” [t] + 62[t] = 0, 62[0] == 0, 62 ' [0] == 0}, 62[t], t]

Al'ordre €, le terme en % 61 [t]? intervient comme un forgage dans I'équation pour 63[t]

1 3
—61[t]’ /. solun
6

1
DSolve[{63”[t] + ©3[t] == —Cos[t]?, ©3[0] ==0, 63'[0] == 0}, ©3[t], t]
6

Tachons maintenant d'analyser ce résultat.

Les deux premiers termes sont conformes a ce que I'on pouvait attendre, avec une petite
correction d'ordre €3au terme en Coslt], et I'apparition d'un harmonique 3 qui vient de la nonlinéarité
cubique.

Par contre, le terme en t Sin[t] diverge aux temps grands, alors que I'énergie est conservée,
ce qui est physiquement inacceptable. Le terme en €3 63 [t ], qui dans notre raisonnement était
sensé étre une petite correction, diverge, donc quelque chose ne va pas!
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Si on analyse le second membre de I'équation différentielle, on voit d'ou provient le prob-
léme :

1
—o1[t]3 /. solun // TrigReduce
6

Cette forme fait apparaitre un terme en CosJt], qui correspond a un forgage résonant, a la
fréquence propre de l'oscillateur.

A-2) Nécessité d'un double développement. Méthode de Poincaré-Lindstedt.

En fait, notre méthode était inadaptée dés le début. En effet, avec le développement choisi
les termes non linéaires ne peuvent faire apparaitre que la fréquence du terme linéaire, et ses
harmoniques. Or nous avons calculé au TD précédent la fréquence de l'oscillateur dans le cas
général, et montré qu'elle dépend de I'amplitude. La bonne méthode consiste donc a faire un double
développement, en supposant dés le départ que la solution cherchée dépend d'une variable 1= w't
ou w est une fonction de €. On aura ainsi
06 060t 86 &6 a(ae) ,0° 6

—_— =) — _— w~ —
ot ot ot ot ot: ot\ot R

Explicitons maintenant le double développement. (on ne garde dés le départ que les termes qui
vont vraiment servir, en éliminant les termes en € w1 et en € 62!)

Remove["Global ™ *"]

w =1+ w2e?;

o[t] = eo1[t] + €%03[t];
Series[w? (0:,: ©[t] ), {€, 0, 3}]
Series[-Sin[O6[t]], {€, 0, 3}]

L'équation différentielle a I'ordre € est donc inchangée (notez toutefois la syntaxe trés légerement
différente; pourquoi avoir choisit cette syntaxe?)

solun = DSolve[{©61"[t] + ©1[t] =0, 61[0] ==1, ©1"'[0] == 0}, 61, ]

A l'ordre €, le terme de forgage devient
1 3 .
forcage = -2w261”[t] + —61[t]° /. solun // TrigReduce
6

On retrouve donc le terme précédent, avec en plus un terme de forgage en w2 Cos[1]. On peut
alors choisir w2 de fagon a supprimer tout terme de forgage résonant!

-1
w2 = —;
16
forcage

soltrois = DSolve[{63"'[t] + ©3[t] == forcage[[1]], ©3[0] == 0, ©3 '[0] == 0}, €3, t]
((e[z] /. solun) /. soltrois) /. {t > wt}

Cette solution est maintenant physiquement correcte. Il apparait bien des harmoniques, mais la
période de la solution dépend de I'amplitude €, et les termes en 1 Sin[1] ont été éliminés. On vérifie
que I'on retrouve le résultat du TD précédent; en effet la période que nous venons de calculer, a
l'ordre €2vaut

27
Series[ —, {e, 0, 2}]
w
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tandis que le développement limité de la formule générale, au méme ordre, donne

Series[4 EllipticK[Sin[i]z] , {e, 0, 2}]
2

B) Développement asymptotique : Application.

Si l'on veut une solution précise, il faut calculer beaucoup de termes, ce qui devient vite trés lourd a
la main. L'idée est d'utiliser les possibilités du calcul formel pour mener les calculs automatique-
ment.

B-1) Pousser le développement a I'ordre €’. (avec les mémes conditions initiales 6(0) = € et 8'(0) =
0).

Si vous ne vous sentez pas trop a l'aise, vous pouvez commencer par faire les calculs
"manuellement”, c'est-a-dire en procédant par copier / coller pour écrire vos commandes.

Il est néanmoins possible de contruire une procédure qui fasse l'intégralité du calcul automatique-
ment. Voici quelques astuces qui vous permettront de construire ce programme

(1) Ecriture automatique des développements
e[t] = Sum|e! ToExpression["e" <>ToString[i]][t], {i, 1, 7, 2}]

Quelques astuces pour la suite:

(2) La fonction coefficient [poly, X, n] vous permet d'extraire les coefficients de la variable x
d'un polynédme poly, prise a l'ordre n

(3) Pour obtenir un polyndme a partir d'un développement en série, appliquer la fonction Normal[ ]
(4) Il est fortement conseillé d'utiliser comme syntaxe dans Dsolve celle qui permet d'obtenir le
résultat sous forme de fonction pure

(5) Pensez a utiliser Flatten pour contréler la "profondeur” des listes fournies automatiquement
par le logiciel.

B-2) Comparer le résultat de votre calcul a une intégration numérique de I'équation différentielle,
pour diverses valeurs de €. (A I'ordre 7, le résultat reste trés bon méme si € est plus grand que 1)

B-3) Le développement asymptotique donne un développement (a quel ordre?) de la période en
fonction de €. Comparer avec la formule analytique de la période obtenue au TD précédent.
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Equation de Korteweg-de Vries

Nous allons étudier dans ce TD quelques solutions de I'équation de Korteweg-de Vries (KdV)

Ot W+ Wox Y + Oxxx@ =0
Cette équation décrit la propagation d'ondes (par exemple, les ondes de gravité a la surface d'un
fluide de profondeur uniforme, petite devant la taille typique des ondes) a une dimension, en régime
nonlinéaire. Cette équation, a la fois dispersive (terme en 0y x x @) et non linéaire (terme en Wox W)
présente des propriétés remarquables.

Elle posséde comme solution des ondes solitaires, excitations nonlinéaires qui réalisent une
balance exacte entre effets dispersifs et nonlinéaires, et se propagent sans déformation. Nous les
étudierons dans la partie I.

Nous verrons dans la partie Il qu'il est possible de trouver une solution exacte décrivant la
propagation, et l'intéraction, de deux ondes solitaires. Cette intéraction est élastique, les deux
ondes retrouvant leur profil aprés l'intéraction. Comme elles gardent leur individualité, on les appelle
solitons, par analogie avec la physique des particules.

Nous ne le montrerons pas, mais ce résultat se généralise a un nombre quelconque de
solitons. L'équation KdV est un exemple, désormais classique, d'équation intégrable.

| - Solution de type "Onde solitaire"

La méthode que nous allons utiliser est tout-a-fait générale, et permet de trouver des solutions de
type "onde solitaire" dés qu'elles existent. Une onde solitaire est une excitation localisée (donc nulle
en o) se propageant comme une onde, a une vitesse V. Plus précisément, nous cherchons (et
rien ne dit a priori qu'elles existent!) des solutions de la forme

Wx,t)=WYé=x-Vt), avec Y(to) =0
On considérera des ondes se propageant vers la droite, donc avec V > 0.
| - 1) Chercher une solution de KdV sous cette forme. Aboutir a une équation différentielle pour W[¢]

| - 2) Intégrer une premiere fois cette équation. Mathematica n'écrit pas la constante d'intégration :
quelle est sa valeur pour une onde solitaire?

| - 3) L'équation s'écrit alors formellement comme un probléme de mécanique décrivant le mouve-
. du
ment d'une particule a la "position" W dans un "potentiel" UV : ¥ = —@. Identifier le potentiel U[WV]

et le représenter graphiquement pour V = 1.

| - 4) Identifier, pour une valeur quelconque de V, les positions d'équilibre pour ce potentiel. Déter-
miner leur stabilité.

I - 5) Montrer qu'il existe des solutions oscillantes. Quelle inégalité vérifie leur "énergie mécanique"?
Faire un portrait de phase pour cet oscillateur (pour V = 1). Quelle "énergie" correspond a la sépara-
trice?

NB : On peut aller voir en fin de TD le complément sur les portraits de phase

| - 6) Expliquer que la solution "onde solitaire" du probléme d'ondes nonlinéaires correspond a la

séparatrice pour le probléeme mécanique associé. Calculer cette onde solitaire, et la représenter
graphiquement.
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Il - Solution a deux solitons

lI-1) Transformation de Cole-Hopf

On fait la transformation y = 0, p, puis on intégre sur x. L'équation de KdV se met alors sous la
forme
0P + 3(0x P)? +0xxxp = 0

Faire dans cette expression la transformation de Cole-Hopf, qui consiste a poser

oy F
p=12=

(Rq importante : Il faut définir la fonction p a partir de la fonction F, comme ci-dessous)
Ox F[x, t]
F[x, t]

plx_, t_] :=12

[I-2) Réécriture de la solution a un soliton

Vérifier qu'on retrouve la solution a un soliton en posant
F=1+exp(6) ou B =-a(x-a) + a’t

lI-3) Solution a deux solitons : Méthode de Hirota

Nous allons chercher une solution a deux solitons par la méthode de Hirota. L'équation aux
dérivées partielles vérifiée par F s'écrit

FoyxxxF = 40x FOyxx F + 3(0xxF)? + FOx(F - 0x FO;F =0
On se propose de la résoudre par un développement formel

F=1+€eF1+&F2+eF3+..

ou € ne sera considéré comme un petit parameétre que pour résoudre le probléme ordre par ordre.
En fin de calcul, € doit étre pris égal a 1. Ce type de méthode transforme une équation aux dérivées
partielles non linéaire en une hiérarchie (infinie, a priori) d'équations aux dérivées partielles
linéaires. On ne gagne donc strictement rien! Sauf si, comme nous allons le voir, cette hiérarchie
d'équations se révéle n'en comporter qu'un nombre fini!

I — 3 — a) Obtenir les équations jusqu' a1' ordre €* inclus.

(Rq : penser que pour utiliser les fonctions d'analyse de polynémes (telles que coefficient, par
ex.) sur un développement en série il faut mettre celui-ci sous forme "normal" avec Normal)

Clear[F]
[1-3-b) Vérifier que la fonction
F1[x,t] = Exp[@1[xt]], ou O1[xt]=a (x-a) - a3t
est solution de I'équation obtenue a l'ordre €.
[I-3-c) L'équation obtenue a I'ordre 1 étant linéaire, on peut prendre une forme plus générale pour
F1[x,t]. On posera donc
O1[x, ]=a(x-a) - a°t
62[x, f]=B(x-b) - Bt
En déduire I'équation vérifiée par F2[x,t]. Montrer que la forme de F2 est y Exp[01 + 62], et calculer
la constante y.

F1[x,t] = Exp[61[x,1]] + Exp[62[x,1]], ou {

(Rq : Bien penser a effacer la définition précédente de F1)

II-3-d) Reporter dans I'équation pour l'ordre € les solutions trouvées pour F1 et F2. En déduire
qu'on peut prendre F3 = 0. Faire le méme calcul pour F4. En déduire Fn = 0 pour n > 3.
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(Rq : Comme précédemment, nettoyer la définition de F2.)

[I-3-e) Calculer la solution trouvée F[x,t]. On prendra comme valeur des constantes a=1, §=2,a =
0 et b =-10. Tracer la solution a t = 0. Pourquoi cette solution est-elle dite a deux solitons? Estimer
les vitesses de chaque soliton. Leur amplitude était-elle prévisible? Proposer un dessin lorsque le
plus rapide a rejoint le plus lent, puis lorsqu'il I'a dépassé. Conclure.

(Rq : Les fonctions d'animation de graphiques de Mathematica permettent une représentation
vivante du phénomeéne.)

Complements sur les portraits de phase

Plagons nous dans le cadre d'un probléme de Mécanique du point. Dans un cas trés général, il
s'écrira (pour une particule de masse unité) sous la forme

X = f(x, x, t) avec les conditions initiales xo = x(t = 0), X0 = X(t = 0).
Sous des hypothéses assez large de régularité de la fonction f, on montre qu'il existe une solution
unique a ce probléme.

Il est en pratique assez rare que |'on soit capable d'exprimer la solution a I'aide de fonctions
connues. Ce théoréme d'existence et d'unicité des solutions d'une équation différentielle ordinaire, a
néanmoins une conséquence pratique importante. |l établit en effet que la recherche numérique de
la solution doit donner un résultat, unique pour des conditions initiales données.

Pour se faire une idée du comportement des solutions, il est pratique de faire un portrait de
phase de I'équation, c'est a dire de représenter quelques trajectoires (x(t), X(f)) pour différentes
conditions initiales. De fagon la plus générale possible, ces trajectoires sont obtenues comme la
représentation paramétrique des solutions de l'intégration numérique de I'équation. Commengons
par I'exemple d'une équation différentielle qui n'est pas intégrable analytiquement.

A-1-Oscillateur de Van der Pol

Etudions l'oscillateur de Van der Pol, dont I'équation différentielle sur la fonction u(t), en variables
sans dimensions, s'écrit

u" - g1-uv)u' +u=0
ou € (qui n'est pas nécessairement petit) est le seul paramétre du probléme.
A-1-a) On prend € = 0.1. Résoudre numériquement I'équation différentielle avec les conditions
initiales u(0) = A et u’(0) = 0. L'amplitude initiale A sera choisi aléatoirement entre 0 et 1. Représen-
ter u(t), ainsi que la trajectoire dans l'espace de phase (u, u’).
A-1-b) Reprendre ces questions en partant cette fois d'une amplitude initiale A choisie aléatoire-
ment entre 2 et 4. On dit que /'attracteur de I'oscillateur est un cycle limite. Voyez-vous pourquoi?

A-2-Cas particulier de la conservation de I'énergie mécanique.

Lorsque le probléme présente une intégrale premiére, le dessin du portrait de phase est grande-
ment simplifié. En effet, si I'équation s'écrit
w_ _95
T T du’
ou E, est une énergie potentielle,on en déduit une intégrale premiéere

;—u'z + Ep(u) = Ep, = Cste

et les trajectoires dans l'espace de phase sont donc données par

+\/2(Em-Ep(u)) =u'.

Intégrer I'équation différentielle est donc inutile pour tracer le portrait de phase.
Reprenons le cas particulier du potentiel qui apparait lorsqu'on résout le probléme
mécanique associé a I'équation de Korteweg-de Vries. Je vous propose de vérifier, méme si cela va
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largement de soi, que les deux méthodes donnent les mémes trajectoires dans I'espace de phase.
Limitons nous au cas ou des oscillations existent, et prenons comme valeur initiale W¥(t = 0)

=Y, et Y(t = 0) = 0. Considérons le cas V = 1.



